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 Acts as the mouse. 
 Need to keep contact with 
board!!!! Especially when click and 
drag 
 Right-click usually pops up a menu.  
 Do not hold button except to 
right-click 
 

 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
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Calibration screen.  
Method 1 - Hover the ActivPen over the 
Calibration light in the top-left corner of the 
ActivBoard for a few seconds.  
Follow the on-screen instructions. 
Method 2 – At your computer, right-click on 
the ActivManager icon in the bottom right-
hand corner.  
Select Calibrate.  
Follow the on-screen instructions. 
 When finished, check that the tip of your 
ActivPen lines up with the cursor on the 
ActivBoard 

NOTE: It is very important that you touch in 
the middle of the crosshairs on each of five 
crosses. 

 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
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Click on Flipcharts to 
create or open flipcharts, 
OR import PowerPoint or 
SMART Notebook files. 
NOTE: The right side will 
get populated with recently 
opened flipcharts. 

Annotate over the Desktop 

The desktop is displayed in 
between ActivInspire’s 
Browser and the Main 
Toolbox. 
This will be covered in 
another session. 

ExpressPoll, ActiVotes 
and ActivExpressions 
will be covered in a 
later session. 
 
Promethean Planet will 
be covered in a later 
session. 
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Click Configure and explain the right 
side of the screen: 
You will use Register devices when 
ActivVotes and ActivExpressions are 
connected. This comes in a later 
session. 
NOTE: Do not check for updates. 
Until tested, we can't predict if a 
flipchart will be backward compatible. 
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Flipchart page 
Main Toolbar 
Trashcan 
Browser window 

NOTE: The Browser 
Window and the 
Flipchart Trashcan 
can be viewed or 
hidden using the View 
Menu. 

Browser Windows and Toolbox are 
pinned/unpinned. 
View menu to View the Browser. 
Position the toolbox where it is the 
easiest to use   

Menu bar 

Same as the Main Menu icon in the Main 
toolbar. Allows you to work from the 
right side of the board. 
Multiple Flipcharts and Document 
Tabs 
Every time you open or create another 
flipchart, anew Document Tab appears 
in the Menu Bar. To move from one 
flipchart to another, click the 
Document Tab of the flipchart you want 
to work on. The name of the flipchart 
appears in bold in its Document Tab. To 
close the flipchart, click on the X. 
NOTE: If you have many flipcharts 
open, you can use the Document drop-
down menu to view other open 
Flipcharts. 
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Increase and decrease the page size with 
Page Scale Options 

With 'Best Fit', you can see the whole page. 
You can change this with the drop-down menu 
at the top right-hand corner of the window.  
Welcome to the World! 
If you select a setting that is smaller than 
100%, the size of the flipchart page will be 
proportionally reduced in the ActivInspire 
window. This opens up an area around the 
flipchart page called the World. You can use 
the World like a blotter, to position objects 
temporarily outside the boundary of the 
flipchart page, for later use. These objects 
can then remain hidden when the page is 
scaled to fit the ActivInspire window. For 
example things you don't want to make visible 
to your students, or items you want to reveal 
at a certain point in a lesson.  
The default color of the World is blue. You 
will learn how to change this in the settings. Design and Presentation Mode 

After you have completed a flip chart, one 
thing you may want to do is lock items so 
that they can not be accidentally move. If 
you need to edit it, instead of going through 
each object and unlocking them, you would 
use Design Mode. 
Design Mode: 
Allow locked objects to be edited  
Show hidden objects 
Disable Actions and Drag a Copy 
Disable object restrictions 
Disable blocker objects 

NOTE: Blue is for Presentation Mode and 
Red is for Design Mode. 

Tip - Use when you download a flipchart to 
analyze it. 
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Fullscreen: 

Hides the taskbar and Title 
bar, including control boxes.  
Click the Fullscreen button 
again to view taskbar and Title 
bar again. 
Have participants switch 
between Authoring and At the 
Board profiles and see how the 
full screen mode is part of the 
At the Bard profile. 

Because the control boxes are gone, 
two new icons appears -  
Show Desktop which minimizes 
ActivInspire to the taskbar. To 
restore the ActivInspire window, 
click on the taskbar.  
A red X appears. Use this to Exit 
ActivInspire. 

Show the Switch Profiles Menu. 
Switch between Authoring and 
At The Board to demonstrate 
the change in the Toolbox, etc. 
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Switch Profiles Tool Menu. 
Switch between Authoring 
and At The Board to see the 
change in the Toolbox, 
Fullscreen view, etc. 

____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
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Use the dropdown menu to load 
different profile files. 
Layout tab: 
NOTE: Watch the changes take place 
as you make selections. 
Change size of icons 
Main toolbox- change the number of 
colors OR Dock top, bottom, left, right 
or floating 

Attach the Main Toolbox to the inside 
edge of the ActivInspire window in the 
chosen position, or leave it floating, so 
that you can drag and drop it as 
required. 

_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
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Layout tab: continued 

Browser window can be docked top, 
bottom or floating; and pinned. The 
Menu bar and Document tabs can be 
docked top or bottom. 
Browser, Menu bar, Document tabs 
and Trashcan can be visible or hidden.  
Use the View menu to see these items 
again. 
Fullscreen mode can be set to come up 
automatically. 

Layout tab: continued 

 
Creating a Student Profile including: 
Main toolbox Pinned and Rolled in 
Browser, Menu bar, Document tabs 
and Trashcan not Visible 
Fullscreen mode set to come up 
automatically. 

_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
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Commands tab:  
Main Toolbox 
NOTE: Watch the changes take place as you 
make selections. 
Personalize the Main Toolbox and Marquee 
and Sizing Handles, by adding or remove 
items to suit your circumstances. 
Any tool may be added and positioned on the 
Toolbox OR on the Marquee Handles. 
 
Continue to create a custom Student profile 
by customizing the Main Toolbox. 

Commands tab: continued 

Marquee and Sizing Handles - the 
icons that appear when an object when 
selected. 
The Edit Shape Points icon is added 
when a shape is selected. Allows you to 
chance the shape of the shape. 
AND 
Edit Text icons is added when Text is 
selected. Opens the Format toolbar 
which allows you to edit the text. 

Commands tab: continued 

 
NOTE: Customize Marquee and Sizing 
Handles by adding or remove items to suit 
your circumstances. 
 
Tip - remove all Marquee and Sizing 
Handles so that when you or your students 
select an object, you don't see them. 
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Have participants 
save this profile 
with a new name - 
'Student' - using 
the Save As icon. 
Continued on next 
page. 
Action button - 
click on Save As 
icon to go to the 
next page. 

Save this profile with a new name - 'Student' - using the Save As icon. 
Browse to the My Profiles folder.  
NOTE: If they don't save it here, it will not appear in the Switch Profiles 
dropdown menu. 
Type a name for the profile. 
Click Save. 
Load different profiles and see how the screen changes. 
 
 

NOTE: Do not browse to 
another folder to save. 

_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
 
_____________________________________ 
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User Defined Buttons tab: 
Create your own shortcuts so that you 
can open a file or launch a program from 
your Toolbar. 
Tip: Great for adding Web site links to 
your toolbar. 

Add User Defined Buttons 

1. Click Add....  

NOTE: The User Defined Button icon is 
displayed. 

2. Select Program/File from the menu. 

Action Button - Click on Program/File 
to go to the next page to finish the 
step. 

Add User Defined Buttons 
(continued) 

3. Click the Find button to 
browse for a file or application. 
OR 
3. Enter a url for a Web site. 

4. Add a Tooltip. 

Tip: Copy and paste a url from a 
web site. 
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NOTE: Select something on the 
left - make changes on the right. 

Select Tools. 

You can change your default tool 
to the Select tool. 

This is the setting to change the 
size of the Compass and make 
other changes to the Tools. 

Help -  

Use the Help menu to find 
information on Settings. 
 

________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
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Pen and Highlighter tools 

Pen creates an annotation that is opaque. The Highlighter creates an annotation 
that is translucent. 
NOTE: The default translucency can be changed in the Settings. 
Setting will be covered in detail in another session. 
Right-click on the color palette to access additional colors. 
Click the color wheel to select custom colors. 
Click the Color Picker (eye dropper) to match a color. 

Pen and Highlighter tools 

Right-click on the color palette to 
access additional colors. 
Click the color wheel to select 
custom colors. 
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Pen and Highlighter 
tools 

Create a custom color. 

Pen and Highlighter tools 

Use the Color Picker (eye 
dropper) to copy a color. 

 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
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Pen and Highlighter tools 

Use the preset widths and slider. 
Preset widths are different for 
Pen and Highlighter. 
NOTE: Largest preset width for 
Pen is the widest that is still 
legible for writing. 
NOTE: In the Settings, if 'Show 
Pen Width Indicator' is selected, 
you will see the size when you 
mouse over the page. 

Pen and Highlighter tools 

Warning!!!!  
When finished using the Pen or 
Highlighter, be sure to change to 
another tool or you may end up 
with more than you expected!!! 
Delete extra Annotations 
- in Object Browser. 
OR - use Clear Annotations from 
Clear icon. 
NOTE: Object Browser will be 
covered in detail in another session. 

Use the Select tool to: 

Click 
Click and Drag 
Double-click 
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Delete Objects 

Use the Eraser on Annotations. 
Change the size of the Eraser using 
the Width selectors. 
Use the Clear icon 
Use the Trashcan 
Use the Delete key 
Delete in Object Browser. 
NOTE: Object Browser will be covered 
in detail in another session. 

Use the Undo and Redo tools. 
Draw or highlight on this page 
use the Undo and Redo tool to 
see how actions are reversed 
and reapplied. 

Shape tool 
Click on the shape tool. Expand the 
shape menu to show all of the 
choices.  

Use the Fill Color Palette for fill. 
The color and width of the outline 
is controlled by the Main Color 
Palette and width slider on the Main 
Toolbox. 
Draw one shape without a fill. 
Draw a filled shape using a standard 
color from the Shapes Fill Color 
Palette. 

mailto:jrybak@westgenesee.org�


Materials created by Jeannie Rybak – jrybak@westgenesee.org 
Updated 01/01/10 

5 

 

Have participants follow 
along using one of the shapes 
they made using the Shapes 
Tool. Click on a shape to open 
the Marquee Handles toolbar.  

Choose the Edit Shape Points 
Tool. 

Show how various shapes can 
be changed using the Shape 
Points. 

  

Fill Tool 
Use this page to demonstrate who to 
change the color of a shape using the 
Fill Tool. 
Draw one shape without a fill. 
Draw a filled shape using a standard 
color from the Shapes Fill Color 
Palette. 
Draw lines - color is outline color. 
Show participants how to change the 
color using the fill tool. 
Select the shape and change color of 
outline. 
Allow Participants time to work with 
the shapes on their flipcharts. 
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Follow the page directions. 
Changing the background 
color will display additional 
text. 

Grouping Objects 

To group objects, you need to 
select them first. 
To select multiple objects: 
Hold down the Ctrl key and use the 
Select Tool.  
OR 
Click and drag around the objects. 
Then, click on the Grouped icon to 
group them together. 
Show how the icon changes when 
the objects are grouped. 
Demonstrate grouping and 
ungrouping using the the square and 
the text.  
NOTE: You can also select objects 
using the Object Browser. Object 
Browser is covered in another 
session. 
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Create a text box. 
Each time you click in a different area of the page, a new textbox is 
created making it quick and easy to make multiple boxes for manipulation 
by students. Great for matching or sequencing activities. 
When you are at the board, you will be using the on-screen keyboard to 
enter your text.  
It is a floating tool. 
When working at a computer, use the computer's keyboard. 

Access and use the On-screen 
keyboard.  

 - May be used to add text to a 
flipchart, or type in another 
application such as entering a URl 
in Internet Explorer. 
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  Use the keyboard.  

 
-  Click F - Show function keys  
-  Click S - Show Symbols   
-  Click double arrow - Show number 
keypad  
NOTE: Use the solid arrows for Shift 
 
Practice using the Floating Keyboard in 
another application. 

Right-click to access different 
keyboards. 

Change to Child - Adult - small- 
large. 

NOTE: The Child keyboard does 
not have the same functionality. 

Clicking on the text box will bring up 
the Marquee Handles Toolbar. 
Clicking on the Edit Text Icon will 
bring up the Text Formatting Toolbar 
and allow you to edit the text. 
 
Create a text box and practice 
editing the text. 
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Spell Check Text 

 
Right click on text to get the 
Object Edit menu 
OR 
Clicking on the text box will bring 
up the Marquee Handles Toolbar.  
Click on the Object Edit menu Icon 
> select Spellcheck Text. 

Use the text box on this page 
to demonstrate Spell Check. 
Point out the entire 
flipchart can be checked 
using the Tools > More Tools 
menu. 

Practice using the Fill tool 
with Text. 
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  Copy text from a Word Doc 
and the Internet. 
 
NOTE: To Highlight and drag - 
resize both windows - Word 
and ActivInpire. 
 
Try this. 

Extract text. 
 
Try this. 
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________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 

Page Browser - Popup Menu 
Have participants follow along as 
you cover the menu items: 
Action button - Click on Insert 
Page to get another menu 
Insert Page Menu - Desktop 
Snapshot and Page Templates 
(takes you to Shared Resources) 
Insert Question - (covered in 
another session) 
Export Page - exports as a picture 
file 
Background and grids - (covered in 
another session) 
Action button -Click on Add to 
Resource Library to get another 
menu Point out the Add to 
Resource Library 
** Duplicate Page - very useful 
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Notes Browser 
Use this to add directions for 
students. 

Add your own notes and 
comments to a flipchart, helping 
to make it easier to share and 
reuse.  

If you are using a flipchart 
created by someone else from 
Promethean Galaxy or 
Promethean Planet: 

View other teachers' notes and 
comments about their flipchart 
and add your own notes where 
appropriate. 

Notes Browser 

Demonstrate - open the Notes 
Browser with the icon. 

Demonstrate using the action 
button. 

NOTE: Actions are covered in 
another session. 

 
__________________________________________________________________________________ 
 
__________________________________________________________________________________ 
 
__________________________________________________________________________________ 
 
__________________________________________________________________________________ 
 
__________________________________________________________________________________ 
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To insert a file quickly - 

Select Insert menu > Media > 
Browse to find the file. 
Tip - great way to insert .tif files 
that were scanned to email. 
Media files (video, sound, flipcharts) 
will be embedded automatically. You 
are not given options for embedding 
or controlling the file using this 
method. 

Videos start automatically when page 
is opened. 
Mouse over the video to get the 
controls. 
Tip – Use Take a Snapshot to get a 
picture of a slide. 
NOTE: If your Snapshot is black, 
you need to - 

• Right-click on desktop 
• Click Properties 
• Click Settings tab 
• Click Advances button 
• Click Troubleshoot tab 
• Change Hardware Acceleration to 
just below 1/2 
• Click OK 

NOTE: Don't forget about 
DeepFreeze! 
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  Click Design Mode to 
get resizing handles. 

Audio files will have sound icon.  
Click the icon to start the sound.  
The Sound Controller launches. It 
can be repositioned on the page.  
NOTE: Play, Stop, and Volume. 
After the sound file is played, an 
new icon appears next to the Design 
Mode icon. You can click here to 
stop the audio. 

Links to video, audio, and data 
files, as well as web links, may be 
inserted into a page. 
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Links to Website 

When you insert the link as an 
Action Object in Design Mode, 
you will see the link object. It 
will be invisible in Presentation 
Mode. 
NOTE: Pick Existing Object and 
the Browse button is activated 
so that you can pick on object on 
the page. 

Links to Files 

When you insert a link to a 
video file, you have more 
options than with Insert 
Media. 
How the file is displayed; 
How it's stored; 
And, with multimedia, how it 
is controlled or played. 

 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
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  Links to File 

A "Select File" window opens. 
Browse to select the file. 
NOTE: You can change the 
selection at any time by 
clicking on the box next to the 
file path and name. 
 

Links to File 

How file is Displayed: 
Text 
Image Icon 
Action Object 
Existing Object 
NOTE: When you insert the link as 
an Action Object in Design Mode, 
you will see the link object. It will be 
invisible in Presentation Mode. 
Pick Existing Object and the Browse 
button is activated so that you can 
pick on object on the page. 

 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
 
________________________________________________________________________________________ 
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Links to File 

How file is Displayed: continued 
Placeholder option allows you to 
pick a frame of the video. 
When you select Placeholder, 
the change placeholder image 
(at the bottom of the page) 
becomes available. 
NOTE: Not all video formats 
work with Placeholder. 
These Video files format may 
be added as placeholders:  
.avi  
.flv (Flash) 
.gif (Animated Gif) 
.swf 
.wmv 

Links to File 
How file is stored: 

• Externally - creates a link to 
the file; keeps file size 
smaller but don't use this 
choice if you plan to share 
your flipchart. 

• In flipchart - embeds the 
file; makes flipchart file 
larger, but when you move or 
share the flipchart, the file 
goes with it. 

File and directory in flipchart - 
adds the file and directory to the 
flipchart. 
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Click to start video 

Explain and demonstrate controls  
Tip – Use Take a Snapshot to get 
a picture of a slide. 
Change Placeholder will replace 
the slide that appears on the 
screen. 
NOTE: If your Snapshot is black, 
you need to - 

• Right-click on desktop 
• Click Properties 
• Click Settings tab 
• Click Advances button 
• Click Troubleshoot tab 
• Change Hardware 
Acceleration to just below 1/2 
• Click OK 

NOTE: Don't forget about 
DeepFreeze! 

Links to File 
How Multimedia files are played: 

• Autoplay - file plays as 
soon as you go to the page 
• Loop - file plays 
repeatedly until stopped 

Controller - allows you to pause, 
start and stop. 
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Tickertapes 

Create a scrolling message for: 
announcements 
reminders 
site words 
Tickertapes can be displayed in any 
application or on the Desktop. 

Access Tickertape 

Tools Menu (or icon) > More Tolls > 
Tickertape 
Three items open: 
- The Default scrolling message: 
Displays changes as they happen 
- The Tickertape Controller: 
Controls the Speed, starts and 
pauses the Tickertape, opens the 
Tickertape Dialog box, closes the 
Tickertape tool. 
- The Tickertape Dialog box: 
Formats the Tickertape. 
Continue on next page 

In the Tickertape Dialog box: 

• Type a message 
• Select the Font 
• Select the Font color 
• Select a Drop Shadow 
• Select a Drop Shadow color 
• Select a Background and Color 
• Select the Position 

Save the Tickertape to use again 
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__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
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Click on the thumbnail to 
display the popup menu. 
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The filmstrip at the bottom of the 
ActivInspire window shows thumbnails of 
the resources in that folder and their 
filenames.  

ActivInspire saves many types of 
resources to the 'My Resources' folder. 
When you use the Tickertape tool, 
ActivInspire creates a 'My Tickertapes' 
folder for you to save your tickertapes in. 
When you use the 'Sound Recorder' tool, 
you get a 'My Sounds' folder. 
This makes it easy to access add 
resources that you created to your 
flipchart. 
NOTE: Use the 'Switch Profiles' menu to 
access your profiles - not the resource 
browser. 

 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
 
________________________________________ 
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 You can add folders to keep 
your resources organized.  
Tip: Create a folder to save 
video files. 

ActivInspire saves many types of 
resources to the 'My Resources' 
folder. 
When you use the Tickertape tool, 
ActivInspire creates a 'My 
Tickertapes' folder for you to save 
your tickertapes in. When you use the 
'Sound Recorder' tool, you get a 'My 
Sounds' folder. 
This makes it easy to access add 
resources that you created to your 
flipchart. 
NOTE: Use the 'Switch Profiles' 
menu to access your profiles - not the 
resource browser. 

 
NOTE: You can use the link on the 
resource browser to go to Promethean 
Planet, but it doesn't bring you to the 
login screen. You will be prompted to login 
when you try to download. 
To download flipcharts and resources, you 
need an ID. 
If you haven't already - create and ID 
and login to www.PrometheanPlanet.com 
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Search for Resource Packs 
To narrow the search 
results, you can type a 
keyword, select a subject 
or grade level. 
Make sure you click 
Resource Packs, then click 
the Search button. 

Browse through the search results to 
find a resource pack. 
To download: 
> Click on thumbnail  
> click Download resource pack  
> click Save (not Open)  
> save it on your desktop 

 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
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You can add your own creations to My 
Resources so that you can easily 
access them again. 
Simply click and drag it to a folder in 
the My Resources. 
Click the popup menu and rename it to 
make it easy to find. 

_________________________________________ 
 
_________________________________________ 
 
_________________________________________ 
 
_________________________________________ 
 
_________________________________________ 
 
_________________________________________ 
 
_________________________________________ 
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Sound Recorder 
Click the sound icon to 
play the recorded sound. 
Click the turkey to play a 
sound downloaded from 
the Internet. 

Use this page to help 
participants locate 
the Sound Recorder 
in the Tools menu. 
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Have participants go to Edit Profiles to see 
the settings. 
They can set it to save their sounds as a 
file. 
The default setting is 'Add to Flipchart'. 
Show participants that the Sound 
Controller can be hidden by Unchecking 
'Show Sound Controller' in Settings > 
Multimedia. 
Have participants save these settings to 
their Authoring profile then go to the next 
page to see how to save a recording. 
 

Sound Recorder 
The default way to record a sound 
Inspire places the recording on the 
page as a sound icon. The file will 
only be on the flipchart page, and 
not saved as a separate file for 
later use. 
Note: The Record button changes 
to a pause button so that you can 
pause and then resume your 
recording. 

If 'Save to Disk' or 'Both' has been 
chosen, when you stop recording, you will 
be asked where you want to save the file. 
The sound icon will appear on the page if 
'Both' has been chosen. If 'Save to Disk' 
is chosen, the file is saved to the location 
that was chosen and will need to be 
added to the flipchart. 
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The Object Browser allows you to easily 
view all objects on a page: the position 
and if the object is locked or hidden. 
When an object is chosen, a menu icon 
will appear in the browser next to the 
selected object. This menu is the same 
menu in the Marquee Handles Toolbar 
Menu and the right-click menu. 
The following page will be used to 
demonstrate ordering, layering, and 
locking/unlocking objects. 

Layers - Top Layer 
You can see how different types 
of objects are listed in the 
Object Browser. There are 
several items created when the 
pen was used to write 'Top 
Layer' because a new object is 
created every time the ActivPen 
loses contact with the board. 
Note: Magic Ink is covered later 
in this session. 

mailto:jrybak@westgenesee.org�


Materials created by Jeannie Rybak – jrybak@westgenesee.org 
Updated 01/01/10 

2 

 

Different types of objects are 
listed with different icons in the 
Object Browser. 
Items that are locked can't be 
selected, moved or edited in 
Presentation Mode. 
Stacking Order - items are 
stacked (within their layer) in the 
order they are added to the page. 
When you add an item it is 
stacked on the top.  
Shapes, images and text items 
still go under the annotations 
because annotations are in the top 
layer. 

 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
_______________________________ 
 
 
 

Hide the words behind the picture. 
Change the stacking order of the picture so 
that it is on top of the text. 
Change the stacking order of the words so 
that they are pulled out in a certain order.  
Lock the picture. 
Place the words in a pile behind the picture. 
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The first three blue balls were made 
using the pen tool at the largest width 
setting (creating annotations). 
The annotation, by default, goes to 
the top layer and the text goes to the 
middle layer. Therefore, the 
annotations are on top of the text. 
The fourth ball was made with the 
shape tool, which goes into the middle 
layer. You can change the stacking 
order so that it is on top of the text. 
Understanding layers and stacking 
order is necessary when creating 
actions and special effects. 

If you drag a picture or object to the 
background layer, the only way to 
delete it is to drag it to another layer 
in the Object Browser. Then you can 
delete it. 

 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
 
__________________________________________ 
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 Magic Ink annotations will hide any 'top 
layer' objects (or parts of objects) 
that the Magic Ink crosses over 
(including annotations and images), 
allowing you to see through to the 
layers beneath.  
Use Magic Ink to reveal the word under 
the picture. 
NOTE: Change the size of the Magic 
Ink tool using the Width Slider. 
NOTE: Magic Ink creates an annotation 
object that can be moved around the 
screen revealing objects beneath. 

 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
 
__________________________________________________________________________________________ 
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Property Browser 
Properties of an object or page can be 
viewed and/or changed using the Property 
Browser. 
Options change depending on what is 
selected. 
Identification - use when creating actions 
NOTE: Page Background, Revealer, 
Spotlight and Grid Designer are each 
covered in other sessions. 

 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
 
_________________________________________________________________________________________ 
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Property Browser - Object Properties 
Properties of an object can be viewed and/or 
changed using the Property Browser.  
Identification - Use when creating actions. 
TIP: Name a group so that you can create an 
action that applies to the group. 
Appearance - Specifies layer object is on  
Depth - indicates stacking order - can't be 
changed here. 
NOTE: The Property Browse offers more 
options - Outline, Fill, and Background areas. 
Actions - click each shape to display the 
properties of each. 

Property Browser - Object Properties - Options change depending on what type of object 
is selectd. 
 

NOTE: Items that are locked won't 
show a tooltip. 

 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
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NOTE: Find sound files  
C:\Documents and Settings\All Users 
\Documents\Activ Software 
\Activprimary3\Shared Sounds 

Very Important: The stacking 
order of the container needs to 
be below the object to be 
contained. 

 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
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These containers were created using 
keywords. 
Many objects can be contained. 
Create different Silly Sentences, 
reset the page and make more 
sentences. 

Property Browser 
Object Properties 
Rotate - Controls the way an 
object can be rotated. 
Restrictors - Define rules to 
restrict the movement of an 
object. 

 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 
____________________________________ 
 

 
 
 

mailto:jrybak@westgenesee.org�


Materials created by Jeannie Rybak – jrybak@westgenesee.org 
Updated 01/01/10 

5 

 

 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
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  Restrictors - Can Block 
The ball can't move outside of the box 
because the lines block the movement. 
The properties of the box were set to 
‘can't move’, but it can rotate. 
 

Restrictors - Can Block 
NOTE: Select each line and set 
restrictions 
OR 
Select and group all four lines. 
Then you can change all at once. 

 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
 
____________________________________________________________________________________________ 
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Action Browser 
- allows objects on the page to be 
associated with various commands. To 
use this browser, there must be 
objects on the page. 
NOTE: You can also insert Documents 
or Media using Insert Link (covered in 
another session). 

Action Browser -  

Drag and Drop 
Easiest way to add actions directly 
on the page OR to an object on the 
page. 
Drag an action to the page and it 
will create an Icon with the action 
attached. You can resize the icon 
by going into Design mode. 

All Actions - list all in alphabetical 
order. Narrow down the search with 
the drop-down menu. 
Select Page Actions 
Tip - Create an object that will Reset 
Page 
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Command Action 
Use command actions to enable a tool 
(the Clock, Dice, Magic Ink) 
OR 
to issue a command (Close Flipchart, 
Open Notes Browser, Print). 
Action - Click on Play. The text box was 
set up to launch the Dice Roller. 
NOTE: Dice can be set to roll two in 
the Settings. 

Object Actions 
Hidden 
NOTE: Hidden is a toggle that 
shows and hides an object 
whenever clicked - click to show, 
click again to hide. 
TIP: You may need to group objects 
when creating actions. 
 

 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 
_____________________________________________________________________________________________ 
 

mailto:jrybak@westgenesee.org�


Materials created by Jeannie Rybak – jrybak@westgenesee.org 
Updated 01/01/10 

3 

 

Object Actions 
Hidden 
Use the star to hide and show the 
text Nice Job!!! 
NOTE: The same object can be 
the target to be hidden when 
clicked. 

Send to Back 
Two cards are stacked. Each card is 
set with the action 'Send to Back'. 
Click on a card. The action sends that 
card to the back. Click again and the 
other card goes to the back. 

Object Actions 
Send to Back 
Sends the Target Object to the 
back of the stack within its layer. 
When action is applied and 
rectangle is click, the correct 
answer will show. 
NOTE: A different object can be 
the target object that is sent to 
the back. 
NOTE: Send Backward moves 
Target Object back one position in 
the stacking order. 
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Object Actions 
Append Text 
NOTE: Use just a single click, 
otherwise, it adds more text each 
time you click. 
Adds text to a text box 
Demonstrate - click the state and 
the capital is added to the text. 

 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 
___________________________________ 
 

Change Text Value 
Use with text 
OR 
Use with numbers - Increases or 
decrease the number by a specified 
amount. 
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New Text Object 
Creates a new text object when 
clicked. 
NOTE: The format of the Text 
created seems to be whatever format 
was last used. 

Stretch actions distort the aspect ratio of 
the target object. 
Stretch Incrementally -The target object is 
increased or decreased by the number of 
pixels specified. 
NOTE: Enter a negative number of pixels to 
decrease the size. 
Stretch Top Incrementally 
In this example, the target object is a 
rectangle 

 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
 
_____________________________ 
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Open Document, file or sound 
NOTE: Use ‘Insert Link’ > to a File works the same way. 
Click a number to play a sound. 
Find sounds in C:\Documents and Settings\All Users\Shared Documents\Activ Software\ 
ActivPrimary3(or ActivStudio3)\Shared Sounds 
 
____________________________________________________________________ 
 
____________________________________________________________________ 
 
____________________________________________________________________ 
 
____________________________________________________________________ 
 

Open Action Browser 

Explain Steps 

1. Select Object  

2. Select Action  

3. Under Action Properties > 
Browse for file  

4. Click Apply Changes - a new 
window opens 

Action - Click Arrow to show new 
window 

5. Decide how file is stored. 

6. If it's a multimedia file, decide 
how it plays. 

7. Click OK 
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